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Version 8.5 Update

Installieren der neuen Pulsonix Version

Es wird empfohlen alle Libraries, Designs, Technologien, Profile Files und Report Files zu sichern, bevor 
Sie das Update installieren. Es ist stets empfehlenswert, regelmäßig Backups zu erstellen, falls es mal 
zu technischen Problemen kommt. 

Um Pulsonix zu installieren, legen Sie bitte die CD ein oder klicken Sie auf das heruntergeladene 
Installationsfile. Folgen Sie nun den Anweisungen auf dem Bildschirm. Sie können Pulsonix 8.5 über 
die bestehende Pulsonix Version installieren. Eine bessere Lösung ist es aber, zuerst die alte Version zu 
deinstallieren. 

Lizenzierung

Die Version 8.5 benötigt ein neues Lizenzfile. Diese erhalten Sie vom tecnotron Support Team. Über-
schreiben Sie dann einfach das vorhandene Lizenzfile mit dem Neuen. Wenn Sie bereits eine Version 
von Pulsonix auf Ihrer aktuellen Maschine installiert haben, klicken Sie bei der Installation bitte auf No 
Change in Licensing. 

Windows XP Unterstützung

Microsoft beendete die Unterstützung für Windows XP im April 2009. Aufgrund der weitverbreiteten 
Verwendung von XP hat Pulsonix den Support für Windows XP weitergeführt.

Unter Berücksichtigung der Pulsonix Support Politik, und aufgrund der Tatsache, dass Windows 8 seit 
zwei Jahren auf dem Markt ist, wird dieses die letzte Version sein, die unter Windows XP unterstützt wird. 

Weitere Informationen zur Unterstützung unterschiedlicher Windows Versionen finden sich auf der 
Website www.pulsonix.com in der Sektion unter O/S Life Cycles.
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Funktionen, die noch in V8.0 geändert oder hinzugefügt wurden
In den folgenden Beschreibungen finden Sie Funktionen, die in späten Veröffentlichungen des Pulsonix 
V8.0 erschienen sind oder geändert wurden. 

Ariadne Import (Advanced Import Option)

Im Import Ariadne Dialog gibt es eine neue Checkbox, Add Net Class for each Net, die Netzen, 
welche im Ariadne Design keiner Netzklasse zugewiesen waren, eine Netzklasse zuordnet.

 
LPKF Output

Im LPKF Setup Dialog gibt es eine neue Option Separate Plots For All Slots. Slots sind nicht-
runde Ausfräsungen (Lang-Löcher) und können auf zwei unterschiedlichen Arten ausgegeben werden: 
geroutet als NC Drill Excellon Typ oder gestanzt.
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Neuheiten in allen Editoren

Änderungen beim Rearrange Multiple Items Befehl

Die Rearrange Multiple Items Option lässt Sie nun Pads mit unterschiedlichen Styles und Kom-
ponenten mit unterschiedlichen Symbolen ausrichten. Das ist besonders hilfreich beim Ausrichten von 
unterschiedlichen Pads im Footprint Editor, oder von Komponenten mit unterschiedlichen Footprints in 
einem Design.

Neuer Enhanced Graphics Modus

Eine neue Option (die bei der Installation von Pulsonix 8.5 automatisch eingeschaltet wird) steht zur 
Verwendung von Enhanced Graphics in Pulsonix zur Verfügung. Dieser neue Modus kann im 
Options > Display Dialog umgeschaltet werden.

Neue Hot-Key Befehle für Dockable Windows

Es gibt neue Hot-Key Befehle, für einige der Dockable Windows. Sie erlauben während der Arbeit einen 
schnelleren Zugriff auf diese Befehle:

Find Bar Layers Bar Both Errors Bars Component Bin:
Select All Find Items All Layers On Find Error Delete From Bin
Select Visible Find Items All Layers Off Delete Error
Refresh Find Bar This Side On Lock/Unlock Error

This Side Off Toggle Sort Order
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Hinzufügen eines Parts zu einem Design aus dem Bibliotheks Manager

Sind der Bibliotheks Manager und ein Schaltplan- oder PCB-Design geöffnet, kann ein Part direkt aus 
dem Part Dialog des Bibliotheks Managers in das Design platziert werden. Dafür darf nur ein Part selek-
tiert sein. Das Part kann wahlweise in die Bin oder direkt ins Design gelegt werden.

Drag & Drop zum Bibliotheks Manager

Für einige Dateiformate ist es möglich die Datei per Drag & Drop auf den Bibliotheks Manager abzulegen. 
Alle enthaltenen Bibliotheksinformationen werden dann übernommen. Das kann jede Kombination aus 
Schaltplan Symbolen, PCB Footprints und Parts sein. Diese Methode funktioniert für die Dateiformate 
Symbole, PCB Footprints, Parts, Schaltpläne und PCB Designs. Mit Ablegen der Dateien auf dem 
Bibliotheksmanager öffnet sich der Import Manager Dialog, der dann durch den Prozess führt.

Unterstützung für zusätzliche externe Bibliotheken

Durch die neue PLX Native ASCII Format Datei, kann Pulsonix nun zusätzliche externe Bibliotheken 
unterstützen, die von den Firmen PCB Libraries, Accelerated Designs (Ultra Librarian) und SnapEDA 
bereitgestellt werden. Jeder Anbieter liefert unterschiedliche und einzigartige Fähigkeiten bei der Erstellung 
von Bibliotheken.

Jeder dieser Bibliotheksanbieter schreibt nun das *.plx Format, welches in den Pusonix Bibliotheks Manager 
eingelesen werden kann, wobei die vorher beschriebene Drag & Drop Methode zum Einsatz kommt.
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Unterdrücken der Properties beim Doppelklick

Wird die neue Options > Interaction Option Suppress Properties on Double Click einge-
schaltet, werden bei einem Doppelklick nur Segmente editiert, es werden keine Properties geöffnet. 

Aktivieren/Einschalten aller Bibliotheken

Die Libraries Seite im Folders Menü hat nun einen Enable All Schalter, um alle gefundenen Biblio-
theken zu aktivieren.

Neues Aussehen der Ordner Listen

Wenn Bibliotheks und Ordner basierende Listen verwendet werden, gibt es nun eine neue Darstellungs-
form des Drop-Down Menüs, das für eine bessere Übersicht sorgt. 
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Gruppenname wird in der Status Zeile angezeigt

Der Gruppenname des ausgewählten Objekts wird nun in der Status Zeile angezeigt

Wird eine ganze Gruppe (und nur diese Gruppe) selektiert, dann wird Multiple Items durch Group 
<name> ersetzt: Anderenfalls wird der Gruppenname der Statuszeile hinzugefügt. Gehören die selek-
tierten Objekte zu mehr als einer Gruppe, wird die Hauptgruppe angezeigt, gefolgt von drei Punkten.

Reiter für Gruppen in den Properties

Es gibt einen neuen Reiter Groups im Properties Dialog, der anzeigt welcher Gruppe die selektierten 
Objekte angehören.

Erweiterte Design Tooltips 

Die Tooltipps Sektion hat nun zusätzliche Schalter, um die Anzeige der Objektgruppe und weiterer Infor-
mationen zu steuern. Das ist im Options Dialog unter Interaction zu finden. Die neuen Kategorien 
sind: Group, Style Name, Style Size, Drill Size, Shape Size und Start/End (von Connection/Track).

Beispiel eines komplexeren           Beispiel eines komplexeren
PCB Design Tooltipps                   Schaltplan Tooltipps
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Zeichne nur das interactive Raster

Es gibt eine neue Checkbox im Grids Dialog, Display Current Interactive Grid Only. Ist diese 
aktiviert, dann wird jedes Raster, das von einer interaktiven Aktion betroffen ist, sichtbar geschaltet, auch 
wenn der entsprechende Haken in den Raster Einstellungen nicht gesetzt ist. Wird gerade kein Raster in-
teraktiv genutzt, werden die Raster angezeigt, die in den Raster Einstellungen gesetzt sind.

Raster mit Kreuzen anzeigen

Es gibt nun ein weiteres ‘cross style’ Raster im Grids Dialog, welches die Rasterpunkte als X-Kreuze dar-
stellt (kleine 45-Grad Kreuze).

Objekte gegen Änderungen sperren

Neue Interaktion – Keine gesperrten Objekte selektierbar

Die neue Option Don’t Pick Locked Items, im Options Dialog, Interaction Reiter, verhindert das 
Anfassen von gesperrten Objekten. Diese Objekte werden in einer gedimmten Farbe angezeigt, um zu 
signalisieren, dass sie nicht selektiert werden können. 
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Lock Status des Layers Bar
Die Auswahl des Picking Locked Items Status kann auch im Layers Browser Bar gesetzt werden. 

Unlock Latch Modus
Der Unlock Latch Mode erlaubt das Selektieren gesperrter Objekte in Folge und entsperrt diese dabei. 

Lock und Unlock Track Segment Auswahl
Beim Verwenden der Lock und Unlock Option, können Sie nun Leiterbahnsegmente selektieren (bisher 
wurde immer die gesamte Leiterbahn selektiert). Verwenden Sie Shift-click, um eine vollständige Leiter-
bahn auszuwählen.

Neue View Highlighted Option

Es gibt eine neue View Highlighted Option im View Menü. Diese Methode zoomt auf ge-highlightete 
Objekte.
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Reverse Engineer – Komponenten Platzierung wie im PCB

Diese Funktion hat nun eine neue Komponenten Platzierungs-Option Place Components To Match 
PCB.

Verwenden Sie Place Components To Match PCB, um das Zentrum jedes Schaltplan Symbols an 
derselben Position zu platzieren, wie das Zentrum der korrespondierenden Komponente im PCB Design. 
Hat eine Schaltplan Komponente mehrere Gatter, werden diese nebeneinander platziert, und dabei um 
diese Position gruppiert.
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Spread Out Option

Die neue Utilities > Spread Out Option bietet ein zusätzliches interaktives Werkzeug zur Platzierung 
von Komponenten. Mit ihr kann man Komponenten auf unterschiedliche Weise ausbreiten, um Platz zwi-
schen Ihnen zu bekommen. 

Bei der Verwendung des Spread-out Modus steht ein neues Kontext-Menü (rechte Maustaste) zur Verfü-
gung.

Das folgende Bild zeigt den Effekt von Spread-out auf ein vorher platziertes PCB.

Das linke Bild zeigt den Ursprungszustand (Vorher), und das rechte Bild das Ergebnis (Nachher).
Es gibt unterschiedliche Spreading Methoden die das Ergebnis des Spread Befehls beeinflussen - Centre, 
Equispace und Spread Out.
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Zyklische Design Backups

Options Dialog

Design Backups haben nun ihren eigenen Bereich im Options Dialog, bisher waren Sie im General 
Register.

 

Außerdem gibt es neue Funktionalitäten für die Design Backups:

Mehrere Backup Kopien
Auf der Design Backups Seite kann die Anzahl der Kopien der Security Copies und Backup Copy 
On Save festgelegt werden.

Ordner für Backups
Für jeden Backup Typ kann ein eigener Ordner definiert werden. 

Anwenderdefinierte Formate für die Backup Dateinamen
Die Formatierung der Dateinamen für Backups kann vom Anwender definiert werden.
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Speichern und Laden von Wiederherstellungspunkten
Ein neuer Backup Typ, genannt Restore Point kann jederzeit manuell gespeichert werden. Er findet sich 
im File Menü und wird verwendet, um ein bekanntermaßen ‘gutes’ Design zu speichern, bevor Änderun-
gen daran vorgenommen werden.

Wiederherstellen eines Backups
Eine neue Option im File Menü, das Restore Backup, steht zur Verfügung, um die Inhalte eines De-
signs mit einem ausgewählten Backup abzugleichen. 

Speicherorte für Reports und CAM Plot Dateien

Sie können nun steuern, wo Reports und CAM Plots gespeichert werden, und wie die Dateinamen forma-
tiert sein sollen.
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Überschreiben der Component Pad Position

Genauso wie der Style, kann jetzt auch die Component Pad Position und Rotation überschrieben 
werden. Das funktioniert im Schaltplan und PCB Layout. Es wirkt ebenfalls auf Doc Symbol Pads, 
Component Mounting Holes und Component Vias. Der Befehl findet sich im Properties Dialog 
eines Component Pad, in Form einiger Override Check-Boxen.

Reload From Library
Reload From Library enthält nun zusätzliche Schalter Keep bond pad position/style overrides 
und Keep pad position/style overrides, welche die Keep bond pad positions und Keep alternative 
pad styles Schalter ersetzen.

Außerdem gibt es einen Keep pin positions/style overrides Schalter im Schaltplan.

Design Revision Analysis
Die Design Revision Analyser Option meldet nun alle überschriebenen Pads.
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Report Maker
Der Report Maker hat nun einen Satz von Is XXXX Overridden Befehlen und einen Satz an Original 
XXXX 

Befehlen:

Is ....Overridden bzw. 

Original ...
Pin Type
Position
Rotation
Style

Zum Beispiel Is Position Overridden und Original Style.

PDF Ausgabe – Eingebettete Schriften

Bei der Verwendung der CAM Plots Ausgabe und PDF, kann nun gewählt werden, ob die Schriften 
(Fonts) in das PDF eingebettet werden sollen. Das wird im Output > CAM/Plot > Plot Settings Dialog im 
Setup der PDF Ausgabe definiert. Der Befehl lautet ‚Embedd Fonts in PDF file‘.

Aktivieren der Net Styles aus dem Technology Dialog

Die Net Styles können nun auch direkt in der Technology > Net Classes aktiviert werden (Bisher nur 
über Setup > Design Settings > General). 

Cross-Probe für Masse-Sternpunkte

Masse-Sternpunkte sind jetzt auch Cross-Probe fähig. Hinweis: Masse-Sternpunkte müssen als Pulsonix 
Star Points, mit dem entsprechenden Doc Symbol Typ, angelegt sein.
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Voreinstellung der Resolve Net Name Parameter

Der Resolve Net Names Dialog erscheint bei Einfüge- oder Kopier-Funktionen, wenn die eingefügten 
Daten Netznamen enthalten, die im Design schon vorhanden sind. Er lässt Sie darüber entscheiden, ob 
diese Netze mit den bereits vorhandenen verbunden oder umbenamt werden sollen.

Die Standard Aktion des Resolve Net Names Dialog wird nun von Optionen bestimmt, die im neuen 
Options > Resolve Net Names Dialog,vorgenommen werden.

Die Auswahl kann für Schaltplan und PCB Editor unterschiedlich eingestellt werden.

Schraffuren (Hatch Lines) verwenden prozentuale Breiten und Positionen

Unter Technology > Hatch Styles, kann die Schraffur nun prozentual zur Linienstärke definiert wer-
den. Außerdem kann die Position der Schraffur (Offset) als Prozentwert der Linienstärke angegeben wer-
den. Dadurch ergibt sich ein verbesserter Einfluss auf das Fluten von schraffiertem Kupfer. 
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Construction Lines – Einen Kreis teilen

Ein Kreis kann nun direkt geteilt werden (Bisher konnten nur die Winkel zwischen zwei Schenkeln geteilt 
werden). Dafür gibt es einen neuen Kontext Befehl beim Arbeiten mit Construction Lines: Divide Angle.

Wenn die Construction Lines im Divide Angle Modus sind, klicken Sie einen Bogen oder Kreis an, um ihn 
zu teilen. 

Hinweis: Wird eine ungerade Anzahl an Segmenten benötigt (z.B. 11), dann muss die doppelte Anzahl 
an Trennlinien angegeben werden (hier: 22). Das liegt daran, dass Construction Lines kein Ende haben, 
und daher nicht auf dem Mittelpunkt des Kreises stoppen. Siehe hierzu das folgende Beispiel mit 11 Di-
oden, die auf einem Kreis platziert wurden. 
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Kein Undo/Redo auf Pan/Zoom

Unter Options > Interaction (PCB & SCM), gibt es nun eine Option das Undo nicht auf Pan und 
Zoom anzuwenden. Ist dieser Schalter nicht gesetzt und es wird ein Undo ausgeführt, werden nur aus-
geführte Funktionen rückgängig gemacht, aber keine Pan oder Zoom Befehle. Wird der Schalter gesetzt, 
verhält sich UNDO wie bisher, macht also auch Zoom und Pan Befehle rückgängig.

Floating / Netzwerk Licenzen - Disconnect Client
In Installationen mit Netzwerk Lizenzen kann Server-seitig eine Trennung eines Clients erzwungen wer-
den. Das ist zum Beispiel nützlich, wenn das Programm auf einem entfernt stehenden Computer nicht 
geschlossen wurde, und nun die Lizenz für andere Anwender blockiert. 

Im Lizenzserver, auf Administrator Niveau, gibt es im Tools Menü den neuen Disconnect Client Befehl. 
Im Connections Reiter des Servers wird der zu trennende Eintrag ausgewählt und darauf der Disconnect 
Befehl angewandt. Bei der nächsten Rückmeldung (Heartbeat) des Clients, gibt der Server diesem eine 
Anweisung zum Schliessen der Sitzung. Der Client verhält sich dann so, als ob die Verbindung zum Server 
unterbrochen wurde, sprich: der Anwender bekommt eine Mitteilung und und die Möglichkeit seine Arbeit 
zu speichern. Danach schließt sich die Anwendung und kann durch Neustart eine neue Lizenz anfordern. 

Technology Files

Änderungen an den bestehenden Technology Files
Alle bestehenden Technology Files (SCM und PCB) wurden verbessert. Sie wurden geprüft und bisherige 
Inkonsistenzen der Styles wurden beseitigt.

Neue Technology Files
Ein neues Technology File namens flexirigid4.ptf wurde hinzugefügt. Es kann für starrflex Boards mit 
vier Lagen (Zwei ‚normale‘ elektrische Lagen und zwei elektrische starrflex Lagen) verwendet werden.

Änderungen der Bibliothek

Neue Parts Bibliothek
Der Master Library wurde eine neue Parts Bibliothek für TDK Filter hinzugefügt.

Die bestehende Hamlin Parts wurden modifiziert, um sie an die Hersteller Part-Nummer, Technologie und 
Footprint Areas anzupassen. Footprints wurden für die neuen Hamlin Parts erweitert oder erzeugt. 65 
neue Hamlin Parts für deren SMT Reed-Schalter wurden hinzugefügt.

Die bestehenden Omron Parts wurden modifiziert und aktualisiert; dafür wurden vollständige Part-Num-
mern und Beschreibungen eingefügt. Neue Parts wurden eingefügt, so dass sie nun 152 Parts enthält.
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Neue Doc Symbols eingefügt
Sowohl in den Schematic Doc Symbols, als auch in den PCB Doc Symbols, wurden neue Doc Symbole 
hinzugefügt.

Schematic Doc Symbols für Left, Right und Both Pointer Typen, die für die neue Netz Benamungsfunktio-
nalität als ein Call-Out benötigt werden. Weiter neue Symbole für alternative Zeichnungsrahmen.

PCB Doc Symbols wurden für allgemeine Dokumentationszwecke eingefügt, wie CE-Zeichen, ESD, Draft 
und ‘For Information Only’ Symbole.

Revidierte Footprint Bibliotheken
Zusammenfassung der Änderungen in den Footprint Bibliotheken:

- Bestehende Footprint Bibliotheken wurden entfernt und gegen logischer benamte Alternativen getauscht. 

  Alle existierenden Footprints wurden beibehalten.

- Rationalisierung der Areas von Chip Widerständen, Kondensatoren Dioden und Spulen. Placement  

  Areas wurden modifiziert, um Ihnen eine realistischere Größe zu geben.

- Einfügen von vollständigeren Sätzen von Chip Widerständen, Kondensatoren, Dioden und Spulen 

  Serien.
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Neu im Schaltplan Editor

Anzeige der Seitenzahlen im Design Browser

Im Design Browser gibt es nun eine neue Option im Kontext Menü, Show Page Numbers. Wird sie 
eingeschaltet, zeigt sie die Seitennummer neben dem Seitennamen an.

Text Callouts mit Netznamen

Text Callouts können als Signal-Referenz verwendet werden. Ein Netznamen-Attribut kann angehängt 
werden, das den Netznamen zeigt und dessen Größe sich dynamisch an die Länge des Netznamens 
anpasst. 

Drei neue Textboxen stehen zur Verfügung: Pointer Left, Pointer Right und Pointer Both.
 

24



Text Callouts und Netzname Attribute
Wenn Sie ein Netznamen-Attribut in ein Text Callout einfügen, verwenden Sie den Attribute Substi-
tution Schalter, oder schreiben Sie das Netznamen-Attribut als %%<Net Name>%%. Das %% ist nötig, 
damit das System erkennt, das es den Inhalt des Attributes ausgeben muss, und nicht einfach den Text 
‘Net Name’.

Text Callouts und Netznamen Textausrichtung
In der Text Callout Box können Sie auch die Ausrichtung des Textes einstellen. Es wird empfohlen es zu 
zentrieren.

Text Callouts im Design
Sie können nun in einem Design Text Callouts an Component Pins anhängen, um Informationen 
über den Pin anzuzeigen. Das kann z.B. dazu verwendet werden einen Netznamen an einem Pin anzuzei-
gen, und diesen mit einer dynamischen Text-box zu umgeben. 
Die Attribute Substitution in Text Callouts kann verwendet werden, um sinnvolle Kombinationen, wie Netz-
name und Netzklasse, zu erzeugen, z.B. 
%%<Net Name>%% [%%<Net Class Name>%%]    SDRAM_CKE [Signal].

Text Callouts und Verbindungspunkte im Schaltplan
Text Callouts können nun auch an Verbindungspunkte (Junctions) und Bus Terminals angehängt 
werden.

Änderungen bei der Suche

Option, um nur in offenen Seiten zu suchen.
Find hat nun eine Option Search All Open Pages. Diese findet sich im Kontext Menü im Schaltplan 
Editor.
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Suchen nach Block Instance
Sie können eine Block Instanz jetzt über den Block finden.

Öffnen nur der letzten aktiven Seite 

Unter Options > Display gibt es nun eine Only Open The Last Active Page Option (Nur im 
Schaltplan Editor). Sie spart Zeit beim Öffnen großer Designs, bei dem beim Speichern viele Seiten ge-
öffnet waren. Sie öffnet nur die letzte aktive Seite, die beim Speichern geöffnet war.
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Neu im PCB  Editor
 
Panel Editor – Nutzen erstellen

Überblick
Pulsonix 8.5 führt den Panel Editor ein. Dieser wird nach dem Erstellen des PCB Designs ausgeführt 
und ermöglicht Ihnen PCB Designs in einem Nutzen zu sammeln und zu positionieren. Es gibt Werkzeu-
ge in dieser Option, um die Herstellungsausgaben in Gerber, Excellon und PDF im CAM/Plot Dialog zu 
erstellen.

Wenn Sie Nutzen erstellen, ist es unbedingt empfehlenswert, dass Sie eng mit Ihrem Hersteller zusam-
menarbeiten, um das Beste aus Pulsonix herauszuholen und damit Sie die nötigen Vorgaben vollständig 
verstehen und welche Toleranzen berücksichtigt werden müssen.
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Was können Sie mit dem Nutzen Editor tun?

Sie können ein einzelnes oder mehrere PCB Designs importieren und dann den Nutzen erstellen.

Sie können keine Gerber Dateien importieren, dieser Editor ist nur für original Pulsonix Designs ge-
macht. Sie können dasselbe Design hinzufügen, um mehrere Kopien in einer Anordnung zu haben, oder 
unterschiedliche Designs einlesen, um den Nutzen bestmöglich zu nutzen.

Sobald die Boards positioniert sind, können Shapes zu Dokumentationszwecken hinzugefügt werden. 
Es gibt neue Shape Typen zum Erstellen von Stegen (Tab Routs) und Ritzkanten (V-Score), mit denen die 
spätere Nutzentrennung definiert wird. 

Weitere Dokumentationsobjekte können ebenfalls hinzugefügt werden, als da wären: Bitmaps, Bohrtabel-
len oder User Reports. Eine Erinnerung zu den Bitmaps: Diese können, aufgrund von Begrenzungen der 
Pixel-Auflösung,  nicht in Gerber Daten geplottet werden. Free Pads und Doc Symbols können eingefügt 
werden, zum Beispiel für Passermarken oder Fixierbohrungen. Doc Symbols können auch zur Herstellung 
von Test-Coupons verwendet werden. Texte helfen bei der Dokumentation des Nutzen, das können ‘nor-
male’ Texte oder Bar-Codes sein.

Construction Lines können im Nutzen eingesetzt werden.

Import Optionen erlauben die Verwendung von Gerber und DXF Daten zur Konstruktion von Fräspfa-
den und Stegen.

Zusätzliche Farbobjekte stehen im Colour Dialog unter dem Others Register zur Verfügung. Diese sind 
speziell für die neuen Objekte des Nutzen Editors.

Vor der Ausgabe durch den CAM Plots Dialog, kann der Nutzen mit dem Panel DRC Dialog geprüft 
werden. Dieser hat neue Prüfungen, speziell für Nutzen.
Beispiele für Tab Routs
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Symbol Origin auf das Zentrum der Pads setzen

Symbol Origin auf das Zentrum der Pads setzen
Eine neue Option ist beim Editieren von Symbolen oder Footprints im Kontext Menü verfügbar. Set Sym-
bol Origin At Centre Of Pads setzt den Symbol-Ursprung auf das Zentrum eines Rechtecks, welches 
alle Positionen aller selektierten Pads und Mountingholes einschließt. Ist nicht selektiert, werden sämtliche 
Pads und Mountingholes verwendet. Dieser Befehl kann einem Hot-Key zugewiesen werden. 

Apply Layout Pattern auf mehrere Gruppen

Die Apply Layout Pattern Option kann nun auf mehrere Gruppen gleichzeitig angewendet werden. Diese 
Gruppen können dann in einer Matrix angeordnet sein.
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Netznamen werden in der Leiterbahn angezeigt

Netznamen können nun in der Leiterbahn angezeigt werden. Es gibt neue Schalter dafür unter 
Colours > Others, sowie Options > In-Place Names, um die gewünschten Einstellungen vorzu-
nehmen.

Find Bar - Track Styles

Die Find Funktion hat eine neue Suche: Track Styles. Diese findet Leiterbahnen mit einem bestimmten 
Track Style. Die Funktion ist im Layers Bar, im Kontext Menü, zu finden.
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Importieren von Platzierungen per CSV

Der PCB Design Editor erlaubt den Import von Komponenten Daten im CSV Format. Verwenden Sie die-
sen Import zur Erzeugung eines Basis-Designs, durch Verwendung von Platzierungsdaten wie Position und 
Seite der Komponenten, oder zum Platzieren kritischer Komponenten zu Ihren festgelegten Positionen. 

Beispiel

Beispiel für eine Komponenten Positions Datei in CSV:

Ref,Part Name,Side,Placement Centre X,Placement Centre Y,Rotation

C1,“c“,,Top,18700.0,21800.0,270.0

R1,“R 0.063W SMTF 9K“,,Top,19100.0,22100.0,0.0

R2,“R 0.063W SMTF 9K“,,Top,19300.0,22100.0,90.0

R3,“R 0.063W SMTF 9K“,,Top,19600.0,22100.0,0.0

U1,“SN74AC00D“,,Top,19300.0,21700.0,0.0

Positionieren des STEP Models

Innerhalb des Footprint Editors und PCB Doc Symbol Editors gibt es nun eine grafische Methode zum 
Bestimmen der <STEP Filename>, <STEP Offsets> und <STEP Rotations> Attribute. 

Die Festlegung des Step Models erfolgt aus der Drop-down Liste. Offset Werte und Rotationen werden 
in die entsprechenden Felder eingetragen. Sobald die Werte eingefügt sind wird die Vorschau des Models 
aktualisiert. Das erlaubt eine vollständige grafische Kontrolle der durchgeführten Änderungen.
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Wählen des STEP Filename Model aus der Drop-down Liste

Wird die Insert Attribute Option, für das <Step Filename> System Attribut verwendet, kann der 
STEP Model Filename nun mit der Drop-down Liste ausgewählt werden.

Diese Funktion ist verfügbar beim Einfügen des <Step Filename> Attributs in das Design, in den 
Properties, durch den Attribute Editor, und beim Einfügen dieses Attributes im Footprint- und im 
Part-Editor.

Bei der Auswahl wird Ihnen eine Drop-down Liste präsentiert, die neben dem Eintrag <Place Holder 
Only> auch eine Liste aller verfügbaren STEP Model Dateinamen anbietet.

STEP Model Name in Attribute Editor

Wird im Attribute Editor, <STEP Filename> als neuer Attribut Name gewählt, kann das Model danach 
aus einer Drop-down Liste ausgewählt werden. 
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Das Attribut <STEP Filename> ist für Doc Symbols verfügbar

Das <STEP Filename> Attribut kann nun auch im PCB Doc Symbol verwendet werden. Es funkti-
oniert wie bei den Footprints. Das kann für Objekte wie Montageschrauben und Befestigungsmaterial 
genutzt werden. 

 

Speichern von Step Models

Es gibt einen neuen Befehl für PCB Designs, um alle verwendeten STEP Modelle in einen eigenen Ordner 
zu speichern. 
Der Save STEP Models Befehl findet sich im Utilities Menü.
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Zusammen mit den Änderungen zum festlegen eigener Ordner für die wichtigen CAM Daten und Reports, 
macht es dies leichter eine Baumstruktur der Ergebnis-Ordner zu erzeugen, der sämtliche wichtigen Da-
ten enthält, die dann archiviert oder versandt werden können. 

Der Dialog zeigt Ihnen die Ergebnisse der Analyse der Komponenten und Dokumentationssymbole in 
Ihrem Design, die für  die Verwendung der STEP Modelle nötig sind.

• Wie viele haben Model-Dateinamen zugewiesen, deren Modelle in Ihren STEP Modell Ordnern 
   existieren.

• Wie viele haben Model-Dateinamen zugewiesen, die aber nicht gefunden werden können.

• Wie viele haben keine Model-Dateinamen.

• Wie viele haben ‘unterdrückte` Model-Dateinamen (indem zwar das STEP Filename Attribute 
   eingefügt wurde, der Wert aber leer ist).

Sie können den Report Schalter verwenden, um einen einfachen Report über die Modelle für Ihr Design 
zu erstellen. 

Um die Model-Dateien in einem bestimmten Ordner zu speichern, verwenden Sie den Browse Schalter, 
wechseln Sie in den gewünschten Ordner und benutzen Sie Save Models, um eine Kopie sämtlicher 
gefundener Modelle in diesen Ordner zu kopieren.

Report

Ein Beispiel Report zeigt Ihnen diese Informationen:

STEP Models

-----------

Report Written : 25/11/2014 12:07:15 PM

Design Path : C:\Reference\Designs\STEP Example.pcb

Design Title :

Created : 01/02/2011 11:31:26 AM

Last Saved : 12/10/2012 11:17:25 AM

Editing Time : 17 min

MODELS FOUND FOR ITEMS IN DESIGN

--------------------------------

Model name Items using model

-------------------------------------------------

c-5102321-1-d-3d.stp 1

dpak3p-841x1018h444.stp 1

plcc-44p1658x1658ls127h439.stp 1

MODELS MISSING FOR ITEMS IN DESIGN
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----------------------------------
None
MODEL FOLDERS
-------------
Model Folder
--------------------------------------
c-5102321-1-d-3d.stp C:\Reference\STEP Models
dpak3p-841x1018h444.stp C:\Reference\STEP Models

Zusätzliche DRC Prüfungen

Net Connectivity Check
Der Net Connectivity Check hat nun eine Power Plane Option die 
eine tiefergehende Prüfung von Unterbrechungen in Power Planes vornimmt
– insbesondere bei Split Planes. Hinweis: Das kann wesentlich langsamer sein, 
als die normale Connectivity Prüfung.

Stub Vias Checks
Es gibt eine neue Stub Vias Prüfung im DRC Dialog unter Nets. Sie prüft auf
Leiterbahnen die auf einer Seite nicht angeschlossen sind, oder auf einem Via 
enden, welches nicht an einem Template oder einer Kupferfläche angeschlossen
scheint.

Panel Item Check
Es gibt eine neuen Panel Items On Board Prüfung bei der Erstellung von Nutzen. Diese neue Prüfung 
wird auf Objekte angewandt, die in Ihrer Layer Class die neue Check Items Outside Board Option 
gesetzt haben (Siehe unter Panel Checks in Layer Class Dialog).
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Prüfen von schraffiertem Kupfer (Hatched Copper)

Mit aktivieren der Hatched Copper Option in Technology > Design Rules, berücksichtigen der 
DRC und die Copper Pour Option nun auch die Abstände zwischen den Schraffurlinien, wenn sie 
Abstandsfehler melden, bzw. beim Kupfer fluten Hindernisse umfahren.

Abstände für Staggered Micro-Vias

Unter Technology > Design Rules kann der Mindestabstand zwischen Micro-Vias auf benachbarten 
Lagen-Spannen definiert werden. Es gibt auch einen Schalter (Standardeinstellung ist ‚Ein‘), der es erlaubt 
Vias zu stapeln, obwohl eine Stagger-Distance eingestellt ist.

Die Stagger distance ist der minimale Abstand von Mittelpunkt zu Mittelpunkt, zwischen zwei Micro 
Vias auf benachbarten Layer Spans.verfügbar.

Allow Stacked Micro-Vias erlaubt am Mittelpunkt  ausgerichtete Micro-vias auf benachbarten Lagen-
spannen, sogar wenn die Stagger Distance nicht 0 ist. Durch die Verwendung von Composite Spans 
können Sie Stacked Micro-Vias automatisch einfügen.
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Via in einem SMD Pads

Unter Technology > DFM/DFT, können Vias in SMD Pads erlaubt werden. Normale und Micro 
Vias können unabhängig eingestellt werden.

Das wird dann durch die Via In Pad Prüfung beim Durchlauf des DRC beachtet.

Nur Signalnetze beim Löschen optimieren 

Eine neue Option führt das Optimize beim Löschen von Leiterbahnen oder Leiterbahnsegmenten, 
nur noch dann aus, wenn es Signalnetze betrifft. Das führt bei großen Designs zu einer wesentlichen 
Leistungssteigerung, und optimiert dennoch die meisten Netze. Die Optimize Only Signal Nets 
Option findet sich unter Options > Interaction.

Layers Bar - Show/Hide der Pinnamen

Die Show/Hide Pins Names Option ist nun auch auf dem Layers Browser Bar im PCB Design 
Editor verfügbar. Der Colours Dialog oder der Component Properties Dialog kann weiterhin 
verwendet werden, um den Anzeigestatus zu ändern.
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Erlaube interaktives Verschieben von Bond Pads 
(Chip Packaging Toolkit Option)

In der kostenpflichtigen Chip Packaging Toolkit Option, verwenden Bond Pads jetzt die neue Allow 
Interactive Reposition Funktion, um sie gegen Verschieben zu sichern. Wenn eine Komponente mit 
Bond Pads in einem Design eingefügt wird, haben alle Bond Pads die Allow Interactive Reposition 
abgeschaltet, damit können sie nicht versehentlich verschoben werden. 
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Custom Pads

Neue Bauteiltechnologien oder aber spezielle Anforderungen an ein Design machen es zuweilen nötig, 
dass andere Formen, als die vorgegebenen definiert werden müssen oder aber unterschiedliche Formen 
und Größen für einzelne Layer gefordert sind. Pulsonix bietet für beide Anforderungen Lösungen an.

Die nachfolgend beschriebenen Vorgehensweisen werden üblicherweise im Footprint Editor ausgeführt, 
können jedoch auch im PCB Editor vorgenommen werden, dann gelten die Definitionen jedoch nicht 
grundsätzlich für den Footprint sondern nur explizit für das Design in dem sie gemacht wurden.

1.) Erstellen Sie in der Technology > Pad Styles einen neuen Style, der Ähnlichkeit mit dem ge-
wünschten Style hat. Zum Beispiel rechteckig, je nach dem mit oder ohne Bohrloch. Die Größe sollte 
dem spätere Style in seinen Maximalabmessungen entsprechen.
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2.) Wählen Sie anschließend Setup > Define Pad Shape... Daraufhin öffnet sich der Define Pad 
Shape Dialog, hier wählen Sie den soeben erstellten Pad Style aus. Drücken Sie anschließend Edit  
Shape...

3.) Der Editor öffnet sich. Hier können Sie die Form des Pads editieren oder vollständig neu zeichnen. 
Achten Sie auf passende Rastereinstellungen. Wenn Sie neu zeichnen wollen, können Sie das bisheri-
ge Shape löschen. Die Werkzeuge verhalten sich so wie bei den anderen Pulsonix Editoren auch. Ach-
ten Sie bitte darauf, dass Drill Holes in einer anderen Farbe dargestellt werden als die Form (Shape) 
des Pads selbst. (Hier: Shape = gelb, Drill = rot). Das Shape muss aus einer zusammenhängenden 
Form bestehen, es ist nicht möglich, mehrere separate Shapes als ein Padshape auf der Lage <De-
fault Shape> zu definieren.

4.) Ist das Pad erstellt, speichern Sie es. Es ist dann Teil der Technology.
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Wichtige Punkte im Pad Shape Editor

Pad Shapes müssen auf dem System-Layer <Default Shape> angelegt werden.
Bohrungen müssen auf dem System-Layer <Drill Shape> angelegt werden.
Lagenwechsel werden auch im Pad Shape Editor über den Befehl Change Layer (Hot-Key L) 
vorgenommen.
Im Pad Shape Editor können einzelne Layer nicht ein- oder ausgeblendet werden, es werden immer alle 
Elemente angezeigt. Im Design können die Lagen wieder, wie gewohnt ein- und ausgeblendet werden.

Custom Shapes: DXF-Daten als Padform einlesen  

1.) Erstellen Sie in der Technology > Pad Styles einen neuen Style, der Ähnlichkeit mit dem 
gewünschten Style hat. Zum Beispiel rechteckig, je nach dem mit oder ohne Bohrloch. Die Größe 
sollte dem späteren Style in seinen Maximalabmessungen entsprechen. 
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2.) Wählen Sie anschließend Setup > Define Pad Shape... Daraufhin öffnet sich der Define Pad 
     Shape Dialog, hier wählen Sie den soeben erstellten Pad Style aus. Drücken Sie anschließend Edit 
     Shape...

3.) Im Pad Shape Editor selektieren Sie das bisherige Pad Shape und löschen es.

4.) Dann wählen Sie mit File > Import Design Data ihr DXF-File aus. Im Import DXF-Dialog stellen 
Sie im oberen Teil für die angezeigten DXF-Layer den Import-Layer <Default Shape> ein, ggfs. muss 
der Schalter Use DXF Cutouts gesetzt werden. Stellen Sie das korrekte Format (mm, inch, Dezimal-
stellen) ein. Nach Bestätigung des Dialogs mit OK werden die DXF-Daten importiert. 

Eventuell sollte das importierte Shape gedreht werden, da Pulsonix Dimensionen von Shapes immer mit 
Width < Length (Breite kleiner als Länge) angibt. Die in der Technology ausgewiesenen Maße würden 
sonst nicht mit dem Shape übereinstimmen.
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5.) Nun muss nur noch der Nullpunkt an die gewünschte Stelle verschoben werden. Soll dieser genau in 
der Mitte liegen, bietet sich die Verwendung von Construction Lines an. Mit Insert > Construction 
Lines > Line und der Auswahl RMB > Along Shape werden nacheinander die äußersten Shape-
Konturen angeklickt. 

Ohne den Befehl abzubrechen, wird danach RMB > Bisect gewählt. Nacheinander werden nun erst 
die beiden horizontalen und dann die beiden vertikalen Hilfslinien angeklickt. Mit Esc wird der Befehl 
beendet.

Mit einem Klick auf eine leere Stelle im Design und RMB > Place Coordinate Origin wird der Nullpunkt 
auf den Kreuzungspunkt der Constructions Line verschoben. Dabei muss die Option RMB > Snap to 
Construction Lines aktiviert sein.
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6.) Das Padshape kann nun gespeichert werden und ist damit Bestandteil der Technologie.

Pads mit unterschiedlicher Form auf Top und Bottom

1.) Erstellen Sie in der Technology > Pad Styles einen neuen Style. Die Pad-Größe und Form, gilt 
grundsätzlich erstmal für alle Layer.

2.) Selektieren Sie diesen Pad Style und wählen Sie anschließend By Layer. Daraufhin öffnet sich der 
Edit Pad Style By Layer Dialog, hier wählen Sie unter Layer den Layer, für den eine andere Form oder 
Größe definiert werden soll. Sie können explizit einen einzelnen Layer wählen, dann wird die Form 
und Größe des Pads nur für diesen Layer geändert. Wenn Sie den System-Layer <Top Side> wählen, 
wird die Form und Größe für alle der oberen Seite zugehörigen Layer, also auch z.B. Solder Mask 
geändert.

WICHTIG: 
Änderungen die Sie an dieser Stelle vornehmen, betreffen alle Pads die diesen Style 
verwenden!
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Wenn Sie ein Bauteil im PCB Editor von Top auf Bottom Spiegeln (Mirror), werden die By Layer Definitionen 
erst mitgespiegelt wenn Sie den Haken bei Designsettings > General Pad Exceptions Setzen.

Segmentierte Lotpasten-Shapes

1.) Erstellen Sie in der Technology > Pad Styles einen neuen Style, der die gewünschte Pad-Größe 
hat, in diesem Beispiel für das Thermalpad eines TQFP100-Bausteins quadratisch, 12 mm.   

2.) Selektieren Sie diesen Pad Style und wählen Sie anschließend By Layer. Daraufhin öffnet sich der Edit 
Pad Style By Layer Dialog, hier wählen Sie unter Layer den Layer für die Lotpaste aus. Die Vorgabe 
für die Lotpaste sieht in diesem Fall 9 Flächen der Größe 2.5 mm mit einem Zwischenraum von 0.4 
mm vor, daher kann für das Pad in der Mitte hier bereits die Größe 1mm eingegeben werden. Wenn 
die Vorgabe für die Lotpaste vollständig asymmetrisch ist, kann es sinnvoll sein, hier die Padgröße „0“ 
einzugeben. Mit OK schließen Sie die Technologie.  
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3.) Fügen Sie nun ein Pad mit diesem Style im Bauteil an der gewünschten Position ein. Auf dem Layer der 
Lotpaste sehen Sie ein kleines Pad. Die zusätzlichen Flächen werden auf dem Layer für die Lotpaste als 
Doc Shape eingefügt. Als Strichstärke empfiehlt sich 0.1 mm. Für die Konstruktion und Positionierung 
der Doc Shapes können entweder  passende Rastereinstellungen oder Construction Lines genutzt 
werden.

4.) Nach dem Einfügen aller Pasten Shapes speichern Sie den Footprint in der Library. 
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Notizen

47



ENTDECKEN SIE AUCH UNSERE ANDEREN TOOLS:


